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Overview
PhotoGrid for CDROM is an Image Browser application that displays a grid of thumbnails 
representing the JPEG image files stored on a CDROM.    These thumbnail images are taken 
from a PhotoGrid Catalog File, which must be shipped with the CDROM and selected in 
PhotoGrid.    

You can move the PhotoGrid application, as well as any Catalog Files (usually *.PGC files) 
onto your hard disk.    This will increase performance and allow you to view the JPEG 
thumbnails without having the CDROM inserted into the drive.    In such cases when you 
execute a function from PhotoGrid that requires the actual hi-res JPEG image file (located 
on the CDROM), PhotoGrid will prompt you for the location of the drive.

PhotoGrid can be tailored to the host memory environment with user-selectable options for 
using true color or "color-squashed" thumbnails, using discardable or non-discardable 
memory to hold thumbnails, and for either keeping thumbnails in memory even when they 
are not currently visible or caching them.      PhotoGrid is able to interoperate with other 
applications, such as Adobe Photoshop, allowing the user to launch PhotoShop from the 
grid of thumbnails, or to drag and drop a thumbnail onto the PhotoShop window.

Finally, PhotoGrid for CDROM displays of the NAA-IPTC text caption associated with each 
JPEG image.



NAA-IPTC
The captioning protocol used by PhotoGrid is the NAA-IPTC (Newspaper Association of 
America - International Press Telecommunications Council) in use at thousands of 
publications worldwide.    PhotoGrid supports the following fields from that protocol.

Headline: A concise description of the image.
Maximum: 256 characters.

Caption: A full-length description of the image.
Maximum: 2,000 characters.

Special Instructions: This field will contain information about use restrictions or 
embargos.
Maximum: 256 characters.

City: Where the image was captured.
Maximum: 32 characters.

State/Province: Where the image was captured.
Maximum: 32 characters.

Country: Where the image was captured. Maximum: 32 characters.

Category: Categories are defined by a regional registry. In the USA the registry is 
the Associated Press.
Maximum: 3 characters.

Supplementary
Category: Supplementary Categories are defined by a regional registry. In the 

USA the registry is the Associated Press.
Maximum: 3 Supplementary Categories at 32 characters each.

Photographer: The image's creator.
Maximum: 32 characters.

Title: The occupational title of the Photographer.
Maximum: 32 characters.

Credit: The organization that distributed the image, not necessarily the 
image's owner.
Maximum: 32 characters.

Source: The name of the person/organization who owns the image.
Maximum: 32 characters.

Caption Writer: The name of the person who created the caption.
Maximum: 32 characters.

Original
Transmission
Reference: If the captioned image is a copy of, or a retransmission of, a previously 

transmitted item, this field contains a reference to the original image 
according to the practices of the image provider. If the captioned 
image is the first transmission, this field contains a reference to the 



original image according to the practices of the image provider. The 
image provider's name is to be found in the "Credit:" field.
Maximum: 32 characters.

Keywords/phrases: Keywords are drawn from the Caption. When supplied to an 
image archive/database, keywords are indexed to optimize subject 
matter search speed.
Maximum: 35 characters per Keyword/phrase.



Preferences
User-selectable options are presented in the Preferences Dialog, invoked from the File 

Menu, or invoked from the File Menu or invoked by double-
clicking inside the Status Bar to the right of the Watch Folder 
Name segment.    These options are described below:

 Sort order: The Sort order choices are by: (a) File Name [Ascending]; (b) File
Name [Descending];

Field Showing in
Caption Bar: The Caption Bar is the gray strip immediately under the 

PhotoGrid Menu Bar. As the user moves the mouse pointer over 
each cell in the grid, the contents of the Caption Bar changes, 
displaying the cell's associated file name and part of the 
contents of a field from the file's IPTC record. The Field Showing 
in Caption Bar List enables a choice of which NAA-IPTC field is to
be displayed in the Caption Bar.

Selection Style: This option enables users to choose the way PhotoGrid behaves 
when the mouse button is clicked while the mouse pointer is 
over a grid cell.    With no modifier keys down(such as the Ctrl 
and Shift keys), both selection modes (Windows and Mac) 
behave identically.    Each clicked cell becomes the newly 
selected cell and any previously selected cell is deselected.    
The selection style affects multiple selection behavior.

In Windows-style selection mode, each clicked cell is added to 
the selection list if the Ctrl key is held down when the cell is 
clicked.    Cells that are already selected are removed from the 
selection list if clicked when the Ctrl key is held down.    Also in 
Windows-style selection mode, the Shift key can be used to 
select a range of cells.    Click a cell with no modifiers keys 
pressed.    This becomes the start of the selection range.    Then, 
while holding the Shift key down, click another cell.    This 
second cell becomes the end of the selection range.    These 
user actions cause the entire range of cells from the start cell to
the end cell, inclusive, to be selected.    Note that the start cell 
can be located before or after the end cell.

In Mac-style selection mode, each clicked cell is added to the 
selection list if the Shift key is pressed when the cell is clicked.    
This is similar to multiple selection behavior of icons in the Mac 
Finder.    There is no range selection supported in Mac-style 
selection mode.

Launch App (Full Path): The user can define a "Launch Application" which is any image 
creating/editing application, such as Adobe Photoshop, which 
can open a .JPG file. The Launch Application can be launched 
directly from the PhotoGrid main window. This is done by 
selecting the cell whose file is to be opened and invoking the 
"Launch Document" item from the ThumbNail menu or pressing 
the F5 key. Alternatively, the user can press the RIGHT mouse 
button while the mouse pointer is over the appropriate cell. This
displays a popup menu over that cell which includes a "Launch 



Document" item.

Invoking this menu item will launch the application whose full 
file path is contained in the ) Launch App field in the 
Preferences Dialog. (The full file path includes the drive letter, 
path executable file name and the ".EXE" extension. An 
example of the proper contents of the ) Launch App edit field is:
C:\PHOTOSHP\PHOTOSHP.EXE.)

Once the Launch Application is open and on the desktop, the 
"Launch Application" command will simply cause the Launch 
Application to open another file. For this to work the Launch 
Application must support the Windows 3.1 Drag and Drop 
Protocol. As an alternative, if an application is already open and 
on the desktop, the PhotoGrid user can select one or more cells 
and drag them to the application window. This drag and drop 
feature is limited to using Adobe Photoshop as the drop target.

(Note that if the user opens an image file in Photoshop, or 
another application, without using the SCCPIK For Windows JPEG
Acquire plug in module, makes changes and saves the changes 
without using the SCCPIK JPEG Export with Caption plug in 
module, the resulting file will no longer contain any NAA-IPTC 
caption data. The Software Construction Company is developing
a Photoshop Format plug in module which will enable the 
retention of NAA-IPTC data when drag and dropping files from 
PhotoGrid to Photoshop. The same can be said for any 
application that fully supports the Adobe Photoshop plug in 
module protocol.)

Memory Management
Options: These three options can significantly affect PhotoGrid's memory

usage and performance.

The "Use Discardable Bitmaps" option, when checked, forces
PhotoGrid to create its bitmaps in memory that can 
automatically be discarded and reused by the Windows Memory
Management system, if the memory is needed. This will have no
effect on what is displayed inside the PhotoGrid window or any 
of Photogrid's features. If memory is discarded, a bitmap will be 
automatically re-created when needed, such as when drawing a 
cell in the grid. The default state for this option is ON.

The "Maintain Offscreen Bitmaps" option, when checked, 
forces PhotoGrid to read, to decompress and to convert to a 
bitmap every image file in the Watch Folder, whether or not the 
associated cell is visible in the main window. If the Watched 
Folder contains a large number of image files, enabling the 
"Maintain Offscreen bitmaps" option can require very large 
amounts of RAM memory. This does, however, accelerate re-
draws when scrolling and paging. The default state for this 
option is OFF, which forces PhotoGrid to wait until an associated
cell is on screen before allocating memory for and creating the 
bitmap. This option can be used in conjunction with the "Use 
discardable bitmaps" option so that bitmaps already created will



be discarded if the cell is offscreen and its memory is needed by
PhotoGrid or another application.

The "Display Cells in True Color" option, when checked, 
forces PhotoGrid to display thumbnails in True Color. The 
alternative is have PhotoGrid 'squash' the image's color map to 
256 colors. True Color bitmaps are about three times larger than
the 256-color bitmaps. Off course, True Color display more 
realistically than 256-color bitmaps. 

This option is similar to the "Create True Color Previews" 
option described below. The Display Cells in True Color option 
controls the color quality display in a cell, while the Create True 
Color Previews option controls the color quality display in a 
Preview Window. If the user changes the Display Cells in True 
Color option, he/she must re-create the cells to achieve the 
selected effect. This can be done by re-selecting the Watch 
Folder (by using the " Watch New Directory" item in the File 
menu).

The "Create True Color Previews" option, when checked, 
forces PhotoGrid to display Preview Images in True Color in the 
Preview Windows. The alternative is have PhotoGrid 'squash' 
the image's color map to 256 colors. True Color bitmaps are 
about three times larger than the 256-color bitmaps. Off course,
True Color bitmaps display more realistically than 256-color 
bitmaps. Note that if you change this option only newly created 
Preview Window sizes will be affected.

If memory is low and PhotoGrid is unable to allocate enough 
memory to draw a cell, PhotoGrid will attempt to draw an icon 
instead of the image thumbnail. This icon will appear as a block 
of 1's and 0's with a jagged break down the middle to indicate a
memory problem.

Check Box Options:

Show Quit Alert before
Quitting Browser: If checked, this option forces PhotoGrid to display an alert box 

before terminating.

Support Moving Files
From Browser: This option is always disabled in PhotoGrid for CDROM because 

it is not possible to delete a file from the CDROM.    This option is
valid only in SCC PhotoGrid (not the CDROM version), a dynamic
directory-watching image browser.

Restore Iconic Window
After Dropping: This option is connected to the PhotoGrid feature that enables a

user to drag cells into another application. If that application is 
minimized to an icon on the desktop the user can still drag and 
drop PhotoGrid cells onto that icon. Dragging and dropping 
PhotoGrid cells onto that icon with the Restore Iconic Window 
After Dropping option enabled in PhotoGrid will force the 
minimized target application to restore itself (open its window) 



immediately after processing the dropped cells.

Use Smooth
Window Resize: This option, when checked, allows the user to resize the 

PhotoGrid window to any horizontal and vertical size up to the 
size of the entire desktop.    As the overall window is resized, 
space will be inserted or extracted from between the individual 
cells in order to account for the larger or smaller cell area.    The 
thumbnail image displayed inside each cell is not changed in 
size.    As the window grows in size, the thumbnails are spread 
farther and farther apart until it is possible to add a row or 
column, given the current thumbnail image size.    Similarly, as 
the window shrinks in size, the thumbnails are pushed closer 
and closer together until it is necessary to remove a row or 
column. 

If this checkbox is not checked, the PhotoGrid window size is 
automatically constrained to exactly the size needed to include 
the current number of rows and columns of cells, using the 
minimum of extra inter-cell space.

Dynamic Watching: This option is disabled in PhotoGrid for CDROM.    It is used in 
SCC PhotoGrid (not the CDROM version), a dynamic directory-
watching image browser.

Refresh Every: (not valid in PhotoGrid for CDROM - see Dynamic Watching, 
above)

Printing Options:

Proof Printout
Font: This combobox enables the choice of a font for the Proof 

Printout

Catalog Printout
Font: This combobox enables the choice of a font for the Catalog 

Printout

Custom Printout
Text: The text entered here is included in the header of the Proof and 

Catalg printouts.

Custom Printout
Field Text: The text entered here is included in a field in the Proof printout.



Caption Bar
The Caption Bar can be displayed just underneath the menu bar near the top of the 
PhotoGrid window.    Use the View Menu to display or not display the Caption Bar.

The Caption Bar displays text information associated with the cell currently under the 
mouse pointer.    As you move the mouse pointer from cell to cell, the Caption Bar updates 
to show the filename of the image file whose thumbnail is displayed in the underlying cell, 
and also displays a portion of the IPTC text associated with that cell.

If the image file associated with the cell has no caption, the text <<No Caption>> is 
displayed.

You can choose from a list of possible IPTC fields or field combinations to display in the 
Caption Bar.    (See Preferences).

If you click the right mouse button on the Caption Bar, a popup menu appears enabling you
to choose a new Caption Bar category.    This is an alternative means of changing this 
category without using the Preferences Dialog.

Related Topics:    Status Bar



Status Bar
The Status Bar can be displayed at the bottom of the PhotoGrid window.    Use the View    
Menu to display or not display the Status Bar.

The Status Bar generally displays text information describing the status of the grid of cells, 
including the volume name of the CDROM where the image files are stored, the catalog 
filename, the sort order of the cells (See Preferences - Sort Order), and the number of 
thumbnails contained in the grid, whether visible or off-screen.    At times the Status Bar 
describes transient operating conditions, such as when a new Catalog File has been chosen 
and is being read the Status Bar displays "Reading New Catalog...".

If you click the right mouse button on the Status Bar, a popup menu will appear enabling 
you to select a new cell sort order.    This is an alternative means of changing the sort order 
without using the Preferences Dialog.

In addition, the Status Bar responds to mouse double-clicks.    If you double-click inside the 
Volume Name / Catalog Name segment at the left of the Status Bar, then the Select New 
Catalog dialog will appear, exactly as if you invoked the appropriate item in the File Menu.  
If you double-click anywhere else in the Status Bar, then the Preferences dialog will appear,
exactly as if you invoked the appropriate item in the File Menu.

Related Topics:    Caption Bar



Caption Viewer
Each cell in the grid can have an associated IPTC caption which can be viewed by 
PhotoGrid.

The caption viewer is invoked by double-clicking the cell whose caption you want to view.    
If the image represented by the cell does not have a caption, either a blank caption will be 
displayed or a warning message will be displayed, depending upon how the image file was 
processed before being inserted into the catalog file.

The caption editor displays each field of the IPTC caption text in its dialog.    You can learn 
more about these fields by viewing help on NAA-IPTC.    Some caption text is placed in 
multi-line edit controls, such as Caption, Headline, and Special Instructions.    Object Name, 
Original Transfer Reference, and Date are presented in single-line edit controls.

Keywords may be present and displayed in the Keyword List.



Cell Popup Menus
Every cell in the grid has its own menu that pops-up when use click the right mouse button 
while the mouse pointer is over the cell.    This menu enables you to initiate an operation on
the single cell in question, regardless of the selection state of that cell or any other cell. 
(Selected cells appear with a red border - see Cell Selection).    The operations available in 
the cell popup menu are:    View Caption, Launch <Cell Image>, Preview <Cell Image>, 
Copy <Cell Image>, and Print <Cell Image>, where <Cell Image> is the image represented
by the cell and is denoted in the menu be the image filename.



Cell Selection
Cells can be in the selected state or in the unselected state.    To select a cell, simply click 
the left mouse button while the mouse pointer is over the cell.    The cell appearance will 
change to indicate that it is selected showing a red border.    If you click a different 
(unselected) cell, the previously selected cell will "deselect" and the newly clicked cell will 
be selected.

You can select multiple cells by holding down the SHIFT key while clicking.    (PhotoGrid uses
Macintosh-style multiple selection).

The reason to select a cell (or cells) is to direct an action at the selected cell (or cells).    For 
example, if you want to print a proof of a cell, you can select it and invoke the Print 
Selected Proof(s) menu item in the File Menu.    The PhotoGrid menu items automatically
enable and disable themselves depending upon whether any cell is selected.    For example,
if no cell is selected, Print Selected Proof(s) will be disable, an dit will be enabled once 
one or more cells is selected.    (See Cell Popup Menus for another way to initiate operations
on cells.)

Some operations can operate on multiple cells, such as Print Selected Proof(s) and Print
Selected Catalog, while others can operate only on a single cell, such as View Caption.   
If multiple cells are selected and you invoke Edit Caption from the Thumbnail menu, an 
intermediate list dialog will appear listing all selected cells (by filename) and requiring that 
you select one.

All cells in the grid, visible or not, can be selected by pressing the Ctrl-A key combination.   
All cells can be deselected by pressing the ESC key or the Ctrl-Shift-A key combination.    
There also are menu items for these operation in the Grid Menu.

If you want a list of all currently selected cells, even those not showing in the PhotoGrid 
window, press the F8 key, or use the Selection List... menu item in the Thumbnail Menu.
Each selected cell is listed by filename.    If you double-click on one of these filenames, the 
PhotoGrid window will scroll to that cell (if it was not already visible in the window) and 
briefly flash that cell.    This feature can assist you in locating a particular selected cell by 
filename.



Drag And Drop Support
PhotoGrid supports the Windows Drag-and-Drop Protocol both as a client and as a server.    
This means that you can initiate operations using PhotoGrid by dragging cells to other 
windows, including other application windows.    In particular, you can drag cells to Adobe 
Photoshop and, when dropped, will be opened with Photoshop. (Photoshop uses the 
filename extension to determine the data format of the dropped image file.)    Photoshop is 
currently the only application that has been tested and verified to work with PhotoGrid 
using the drag-and-drop mechanism.

Also, you can drag files from the Windows File Manager and drop them into the PhotoGrid 
window.    This will initiate the operation of file copy or move from the file's source directory 
to the PhotoGrid Watch Folder (Directory).    An intermediate dialog will appear asking you 
to confirmthis action.    Once copied (or moved), the file will appear (in thumbnail form) 
inside the grid of cells.

You cannot drag cells from PhotoGrid to the File Manager.    File Manager was not designed 
for this.

You can drag cells from the main PhotoGrid window and drop them onto existing Preview 
Windows.    This will force the Preview Window to re-draw itself using the dropped cell.

Note that you cannot drag cells from PhotoGrid and drop them into the grid.    This is 
evident when tried by the mouse pointer shape (a circle with e diagonal line through it).



Printing A Catalog of Selected Cells
PhotoGrid can be used to print a catalog of all or a subset of the image files in the Watch 
Folder.      The data use for printing images is contained in the image file located on the 
CDROM.    Therefore, if you have copied the catalog file to your hard disk and attempt to 
print (for the first time for this image catalog file), PhotoGrid will prompt you to enter the 
drive letter where the appropriate CDROM is located.

Select all or some of the cells and invoke the Print Selected Catalog menu item in the 
File Menu.    This will begin the printing of each selected cell image in the catalog format.    
This format has 5 images per printed page and includes the file's caption text.



Printing Proofs of Selected Cells
PhotoGrid can be used to print proofs of all or a subset of the image files in the Watch 
Folder.      The data use for printing images is contained in the image file located on the 
CDROM.    Therefore, if you have copied the catalog file to your hard disk and attempt to 
print (for the first time for this image catalog file), PhotoGrid will prompt you to enter the 
drive letter where the appropriate CDROM is located.

Select all or some of the cells and invoke the Print Selected Proof(s) menu item in the 
File Menu.    This will begin the printing of each selected cell image in the proof format.    
This format has 1 image per printed page and includes a large (approx. 7 inch by 7 inch) 
image and also includes the caption text and other IPTC field text.



Resizing Cells
PhotoGrid will display thumbnails in various sizes.    To change the size of the displayed 
thumbnail, invoke the Resize Cells... item in the Grid Menu.    A dialog will appear 
containing a combobox filled with thumbnail size options and two numeric edit fields..    To 
choose one of the pre-defined thumbnail sizes, select the desired thumbnail size from the 
combobox list and click the OK button.    To enter an arbitrary width and height (between 32
and 256, inclusive), enter the numeric width and height in the edit fields.

The width and height values in the combobox actually represent maximum thumbnail 
image size, not cell size.    "Maximum" size means that the thumbnail image is stretched 
equally in both the horizontal and vertical dimensions (no distortion) until either the width 
or the height equals the selected width or height denoted in the combobox.



Launching Another Application From A Cell
The user can launch an "image creating/editing" application, such as Adobe Photoshop, 
directly from the PhotoGrid window.    This is done by selecting the cell that is to be opened 
(that is, the cell whose file is to be opened), and invoking "Launch Document" from the 
ThumbNail menu (or press the F5 key).    Alternatively, you can press the right mouse 
button while the mouse pointer is over the desired cell.    This creates a popup menu over 
that cell which includes the "Launch <filename>" menu item.    (See Cell Popup Menus)

Invoking this menu item will launch the application whose full pathname is contained in the
Launch App entry field in the Preferences Dialog.    (See Preferences)    You must include the 
full pathname, including the drive letter, path, executable filename and its extension (.EXE)
in this field of the Preferences Dialog.    This launch application must support "command line
parameters" if it is to open the cell file (most applications do).    An example of the proper 
contents of this Preferences field is:

C:\PHOTOSHP\PHOTOSHP.EXE

Once the Launch Application is open and on the desktop, the "Launch Document" 
command will simply cause this application to open another document.    For this to work 
the Launch Application must support the Windows 3.1 Drag and Drop Client Protocol.      

Note that if you open an image file in Photoshop or another application, make changes, and
save them (to a hard disk), the file will no longer contain the caption.    Special Photoshop 
plugins are currently being developed by The Software Construction Company that will 
allow a user to use Photoshop to edit and save the image and its caption and, 
subsequently, save the image and its caption back to the file.



Previews (Blowups)
Previews are "previews" of a cell's associated image.    The data used to create the preview 
image is of a higher resolution than that used to create the thumbnails displayed in the grid
cells, but is still low enough in resolution to facilitate a relatively rapid display of the image. 
Previews are displayed in the PhotoGrid Preview Windows.    This data is contained in the 
image file located on the CDROM.    Therefore, if you have copied the catalog file to your 
hard disk and attempt to create a Preview Window (for the first time for this image catalog 
file), PhotoGrid will prompt you to enter the drive letter where the appropriate CDROM is 
located.

To create a Preview Window for a particular cell, select the cell and invoke the Preview 
Cell item in the Thumbnail Menu.    If multiple cells are currently selected a dialog will 
appear showing a list of all selected cells and asking you to pick one of them.    Another way
to create a Preview Window is to click the right mouse button while the mouse pointer is 
over the cell that is to be blown up.    This will popup the cell's menu which contains an item
to create the Preview Window.    And, finally, another way to create a Preview Window is to 
hold down the Ctrl key while double-clicking the desired cell.

Preview windows contain a large size image, an optional caption text area, and a status bar.
The status bar contains buttons to show or hide the caption area, and to change the 
Preview image and caption to that of the next file in the grid.

You can create as many Preview Windows as you like, until memory restrictions become a 
problem.    Note that Preview Window images are held in memory and are not discarded 
until the Preview Window is deleted.

Preview Windows are drag-and-drop clients -- that is, you can drag cells from the PhotoGrid 
main window and drop them into any Preview Window to change the Preview association to
the dropped cell.    You cannot drag from the file manager to a Preview Window.



Copying Files
Each cell in the grid is associated with an underlying image file on the CDROM.    You can 
copy files from the CDROM to any valid destination that you specify.

To copy a file from the CDROM, select the cell and invoke the Copy Selected Files... item 
from the File Menu (or use the Cell's Popup Menu).    This will present a dialog listing all of 
the files designated to be copied(you can select multiple cells before invoking the menu 
function) and requires that you enter the full directory path where these files are to be 
copied.      If you see a file listed that should not be included, select it in the listbox and click
the Exclude button.    The Revert List button will always restore the list to its original 
items.



Cell Searching
If you have a large number of cells in the grid (large number of files in the Watch Folder), it 
may be necessary to use the PhotoGrid Find... command to locate specific cells.    The Find 
command, located in the Thumbnail Menu, operates on cell caption text.    You can 
constrain the text search to just the keywords, to just the Caption Field of the IPTC caption 
record, or you can search the entire caption record.    Check the case-sensitive checkbox if 
you want the search to also match the exact case of the text (as in upper and lower case 
letters).

A special mode of this Find Dialog allows you to search by caption date.    This is the date 
stored within the caption record, not the creation date of the file.

After entering your search criteria, click the Find button and PhotoGrid will search all cell 
captions for a match and select each matching cell.    Then, you can press F8 (or use the 
Selection List... item in the Thumbnail Menu) to see a list of the selected cells and to 
locate any particular selected cell (see Cell Selection).



File Menu
Select New Catalog... Choosing the Select New Catalog... Item displays the standard 

Windows file open dialog.    You can use this dialog to switch to a
new image catalog file, usually having a *.PGC file extension.    
Once you select a new catalog the grid will clear and begin 
filling with the thumbnails of the new catalog.    Another way of 
selecting a new catalog file is by double-clicking the catalog file 
itself in the file manager window.    This will execute PhotoGrid 
for CDROM (if not already executed) or select a new catalog file 
in an already executing PhotoGrid for CDROM.    For this method 
to work, you must have first "Associated" the file extension PGC
with the full path of the PhotoGrid application (EXE) file.    You do
this in the Windows File Manager using the Associate... item in 
the File menu.    (Note:    the Select New Catalog dialog can be 
accessed by double-clicking the Status Bar in the Volume 
Name / Catalog Name segment on the left.)

Preferences... Choosing the Preferences... item displays the Preferences Dialog
and enables you to configure the user options.    (See 
Preferences)

Select CDROM Drive Choosing this menu item wil display a dialog that allows you to 
select the drive where the CDROM disc containing the hi-res and
preview images is inserted.    (See Select CDROM Drive).

Copy Selected Files... This menu item is enabled only when one or more cells are 
selected.    It allows you to copy the underlying image files from 
the Watch Folder (Directory) to another directory. (See Copy, 
Move, and Delete Files)

Print Setup... This menu item provides access to the standard Windows Print 
Setup dialog.

Print Selected Proof(s)... This menu item is enabled only when one or more cells 
are selected.    It allows you to print proofs of the cell images.    
(See Print Proof)

Print Selected Catalog... This menu item is enabled only when one or more cells 
are selected.    It allows you to print a catalog of the selected 
cells.    (See Print Catalog)

Exit This menu item terminates the PhotoGrid application.



View Menu
Show/Hide Caption Bar This menu item can be used to show or hide the Caption Bar.    

The Caption Bar is displayed immediately below the menu bar 
in the PhotoGrid main window and shows a cell's filename and 
caption text.

Show/Hide Status Bar This menu item can be used to show or hide the Status Bar.    
The Status Bar is displayed at the bottom of the PhotoGrid main
window and shows the current Watch Folder, the grid sort order,
and the number of cells in the grid (visible or not visible).

Thumbnail Only This menu item sets the grid format in the main PhotoGrid 
window to draw the image thumbnails only.    Other options are 
Thumbnail & Filename, and Thumbnail & Caption.

Thumbnail & Filename This menu item sets the grid format in the main PhotoGrid 
window to draw the image thumbnails with the image filename 
immediately under the thumbnails.

Thumbnail & Caption This menu item sets the grid format in the main PhotoGrid 
window to draw the image thumbnails with the Caption Field of 
the IPTC record associated with the image.



Grid Menu
Resize Cells... This item allows you to change the size of the thumbnail image 

displayed in the grid.    (See Resizing Cells)

Grow Column This item causes the PhotoGrid window to add one column to its
grid size. This will occur only if the entire grid can still fit on the 
desktop.

Shrink Column This item causes the PhotoGrid window to delete one column 
from its grid size.    

Grow Row This item causes the PhotoGrid window to add one row to its 
grid size.    This occurs only if the entire grid can still fit on the 
desktop.

Shrink Row This item causes the PhotoGrid window to delete one row from 
its grid size.

Go To Top This item scrolls the PhotoGrid window so that the top row of 
the grid is visible in the window.

Go To Bottom This item scrolls the PhotoGrid window so that the bottom row 
of the grid is visible in the window.

Page Up This item scrolls the grid up one page (one window size) in the 
window.

Page Down This item scrolls the grid down one page (one window size) in 
the window.

Select All Cells This item causes all cells in the grid to become selected.

Deselect All Cells This item deselects any cells in the grid that are currently 
selected.



Thumbnail Menu
View Caption... This item is enabled only when one or more cells are selected.    

It invokes the View Caption Dialog (See Caption Viewer)

Launch Document This item is enabled only when one or more cells are selected.    
It attempts to launch the application specified as the Launch 
App in the Preferences Dialog.    (See Launching Another 
Application From A Cell)

Preview Cell This item is enabled only when one or more cells are selected.    
It is used to create a Preview Window.    (See Previews 
(Blowups))

Find... This item allows you to search for cells that contain certain text 
within their IPTC caption.    (See Cell Searching)

Selection List... This item presents a dialog containing a list of all selected cells 
and assists in locating specific cells.    (See Cell Selection)



Select CDROM Drive
Each catalog file (*.PGC file) knows the volume name of the CDROM disc where the hi-res 
image files are located, which may include the medium-res preview images.    These 
preview images are used when printing and when displaying the image in the Preview 
Window (see Previews/Blowups).    If this CDROM disc is not mounted when one of these 
operations is about to execute, PhotoGrid will ask the user to specify the drive letter of the 
CDROM drive containing the proper CDROM disc.    At that time, the user should insert the 
CDROM disc and select the proper drive from the combobox list in the dialog.

The user can change the CDROM drive (for example, from drive D: to drive F:) at any time 
by choosing the Select CDROM Drive menu item uder the File menu (See File Menu).
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